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K I R I SH 

Avtomatlashtirilgan malum otlarni qayta ishlash tizimlari hisoblash 

texnikalarining, dasturlash tillarining va komp'yuterlarning matematik ta'minotining 

rivojlanish va takomillashishiga qarab bir nechta rivojlanish boskichlarini boshdan 

o'tkazdi va bugungi kunga kelib barcha saholarda avxtomatlashgan axborot tizimlarini 

qullanish imkoni yaratildi. 

Ayniqsa qishloq xujaligi sohasiga tegishli ma'lumotlar bazasida saqlanayotgan 

ma'lumotlar bir nechta ko'rinishda va bir nechta "Word", "Excel", "Access" dasturlari 

asosida saqlanmaqda. Bunga qo'shimcha ma' lumotlarning tuzilishi yangi ma'lumotlarni 

kiritish va eskirganlarini chiqarib tashlash, shuningdek saqlanayotgan ma'lumotlarga 

o'zgartirish kiritish imkonini berishida birqancha muammolar tug'ilishlari mumkun. 

MBBT bunday holatlarda ma'lumotlarning yo'qolib ketmasligini va buzilgan 

ma'lumotlarni qayta tiklash imkoniyatini ta'minlashi zarur. Foydalanuvchilar faqat ularga 

kerakli ma'lumotlar bilangina ishlashlari zarur. Boshqa ma'lumotlar dan foydalanish ular 

uchun cheklangan bo'lishi kerak. Tizimda saqlanayotgan ma'lumotlardan bunga tegishli 

huquqi bo'lmagan shaxslar foydalanmasliklari zarur. 

Qishloq xo'jalik ma'lumotlar bazasini avtomatlashtirish, axborotni yig'ish, saqlash 

va qayta ishlash, ishning unumdorlik tizimini oshirib xamda qo'l mehnatini anchagina 

kamaytiradi. Yanada ma'lumotlar bazasi ma'lumotlarni saqlashda va qayta ishlashda ya'ni 

kerakli ma'lumotlarni tez topishda, qayta tahrirlashda katta ahamiyat kasb etadi. 

Bitiruv malakaviy ishi «Fermer» xo'jaliklari ma'lumotlar bazasini avtomatlashtirish 

va ma'lumotlarni xar qil tahlil o'tkazishga yo'naltirilgan bo'lib, mazkur ish «Fermer» 

xo'jaliklari ma'lumotlar bazasini mul'timediali avtomatlashgan tahlil yuritish haqida 

bo'lib, bu foydalanuvchilar uchun «Fermer» xo'jaliklariga berilgan shartnomalar va 

ularning urinlanishini parallel turda jadvalli va mul'timediali tahlil o'tkazga ega bo'lishdan 

iborat. 

Bundan kelib chiqib mazkur muassasaning faoliyatinni avtomatlashtirish dolzarb 

hisoblanadi. 
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Bu maqsadga erishish uchun quyidagi vazifalar qaralgan: 

■S Ma'lumotlar omborida ishlashni mukammal o'rganish; 

S Muassasa strukturasi bilan tanishish va shu asosida malumotlar strukturasini 

yaratish; 

S Ma'lumotlar bazasiga qo'yilgan asosiy talablar bilan tanishib olish, buning 

asosida kerakli so'rovnoma va hisobotlarni ajratish; 

S Malumotlar ombori uchun dasturiy ta minot yaratish, shu bilan birga qulay va 

engil interfeys ishlab chiqish; 

Bajarilgan bitiruv malakaviy ishi kirish, tortta paragraf, xulosa, foydalanilgan 

adabiyotlar ruyhati va ilovadan tashkil topgan. 

Kirishda tanlangan mavzu dolzarbligi isbotlangan hamda bitiruv malakaviy 

ishining maqsadi va qo'yilgan maqsadga erishish uchun asosiy masalalar berilgan, ishning 

tarkibi yoritilgan. 

Birinchi paragrafta malumotlar bazasi haqida asosiy tushunchalar keltirilib otilib, 

har qanday axborot tizimining maqsadi real muhit obektlari haqidagi malumotlarga ishlov 

berishdan iborat ekanliklari keltirilib otiladi. 

Ikkinchi paragrafta Delphi vizual dasturlash vositasida malumotlar bazasini 

yaratish texnologiyalari va undagi MB bilan ishlovchi vositalar tarkibi haqida keltirilib 

o'tilgan. 

Uchinchi paragrafta MBBTda ishlatiladigan ilovalarni tuzish va ishlatish vositalari 

yoki Delphi tarkibiga kiruvchi MBni boshqarishda ishlatiladigan ilovalarni tuzish va 

ishlatish vositalari haqida keltirilib otilgan. 

Tortinchi paragrafta Fermer xojaliklarida malumotlar bazasini multimediyali 

tahlilining dasturiy vositasini ishlab chiqishning algoritmi hakida va ularning bajarilish 

ketma-ketligi keltirilib o'tilgan. 

Xulosada asosiy qilingan ishning natijalari yoritilgan. 

Adabiyotlarning ruyhatida malakaviy bitiruv ishini bajarishda foydalangan 

adabiyotlar keltirilgan. 

Ilovada forma va malumotlar bazasining kodlari berilgan. 
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§1. Ma'lumotlar bazasi haqida asosiy tushinchalar 

Har qanday axborot tizimining maqsadi real muhit ob'ektlari haqidagi 

ma'lumotlarga ishlov berishdan iborat. Keng ma'noda ma'lumotlar bazasi - bu qandaydir 

bir predmet sohasidagi real muhitning aniq ob'ektlari haqidagi ma'lumotlar to'plamidir. 

Predmet sohasi deganda avtomatlashtirilgan boshqarishni tashkil qilish uchun 

o'rganilayotgan real muhitning malum bir qismi tushiniladi. Masalan, korxona, zavod, 

ilmiy tekshirish instituti, oliy o'quv yurti va boshqalar. 

Shuni qayd qilish lozimki, MBni yaratishda ikkita muhim shartni hisobga olmoq 

zarur: 

Birinchidan, ma'lumotlar turi, ko'rinishi, ularni qo'llaydigan programmalarga 

bog'liq bo'lmasligi lozim, ya'ni MBga yangi ma'lumotlarni kiritganda yoki ma'lumotlar 

turini o'zgartirganda, programmalarni o'zgartirish talab etilmasligi lozim. 

Ikkinchidan, MBdagi kerakli ma'lumotni bilish yoki izlash uchun biror programma 

tuzishga hojat qolmasin. 

Shuning uchun ham MBni tashkil etishda malum qonun va qoidalarga amal qilish 

lozim. Bundan buyon axborot so'zini ma'lumot so'zidan farqlaymiz, ya'ni axborot 

so'zini umumiy tushuncha sifatida qabul qilib, ma'lumot deganda aniq bir belgilangan 

narsa yoki hodisa sifatlarini nazarda tutamiz. 

Ma'lumotlar bazasini yaratishda, foydalanuvchi axborotlarni turli belgilar 

bo'yicha tartiblashga va ixtiyoriy belgilar birikmasi bilan tanlanmani tez olishga intiladi. 

Buni faqat malumotlar tizilmalashtirilgan holda bajarish mumkin. 

T i z i l m a l a sh t i r i sh - bu ma'lumotlarni tasvirlash usullari haqidagi kelishuvni 

kiritishdir. Agar ma' lumotlarni tasvirlash usuli haqida kelishuv bo lmasa, u holda ular 

tizilmalashtirilmagan deyiladi. Tizilmalashtirilmagan ma lumotlarga misol sifatida matn 

fayliga yozilgan ma'lumotlarni ko rsatish mumkin. 

Misol 1. Studentlar (sinov daftarchasining nomeri, familiyasi, ismi, otasining 

ismi, o'rtacha baho va stependiya miqdori) haqidagi axborotdan iborat 

tizilmalashtirilmagan ma'lumotlarga misol 1-Rasmda ko'rsatilgan. 
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1-Rasm. Tizilmalashtirilmagan ma'lumotlarga misol. 

Tizilmalashtirilmagan holda saqlanayotgan ma'lumotlardan zarur bolganini 

qidirib topish ancha murakkab, uni tartiblashni esa dyarli bajarib bolmaydi 

1. Reyting daftarcha nomeri 654311 

2. Familiyasi Avazov 

3. Ismi Jamol 

4. Otasining ismi Alievich 

5. Tugilgan sana 15-yanvar', 1979 yil 

6. O'rtacha baho 4,78 

7. Reyt. daft. nomeri 545712 

8. F-yasi Ortiqov 

9. Ismi Akram 

10

. 

Ota. ismi Salimovich 

11

. 

Tugilgan sana 3/XI 1978 yil 

12

. 

O'rta baho 4,61 

13

. 

Reyt. d. nomer 453225 

14

. 

F-yasi Lazizova 

15. Ismi Saida 

16

. 

Otasi. Xo'jaevna 

17

. 

Tugilgan sana 8.08.80 

18

. 

O r. baho 4,52 

19

. 

R/d. nomeri 685564 

20

. 

Fam. Safarov 

21. Ismi Toshmurod 

22

. 

Otasi Karimovich 

23

. 

Tug'il. sana 12-apr., 81 y. 

24

. 

O rtacha b. 4,03 

25

. 

R/d. N 654786 

26

. 

F-ya Javlonov I. Alisher 

27

. 

O. Ozodovich 

28

. 

T. s 31/12/1982 O'. b. 3,69 
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Bu ma' lumotlarni tizimlashtirish va qidirishni avtomatlashtirish uchun ma 

lumotlarni tasvirlash usullari haqida ma lum bir kelishuvni ishlab chiqish zarur.



Misol 2. 1-misolda ko'rsatilgan ma'lumotlarni oddiy jadval ko'rinishidagi 

tizilmaga solingandan so'ng, u 2-Rasmda tasvirlangan ko'rinishga ega bo'ladi. 

 

Ma'lumotlar bazasidan foydalanuvchilar turli amaliy dasturlar, dasturiy vositalari, 

predmet sohasidagi mutaxassislar bo'lishi mumkin. 

Ma'lumotlar bazasining zamonaviy texnologiyasida ma'lumotlar bazasini yaratish, 

uni dolzarb holatda yuritishni va foydalanuvchilarga undan axborot olishini ta'minlovchi 

maxsus dasturiy vosita, ya'ni ma'lumotlar bazasini boshqarish tizimi yordami bilan 

markazlashtirilgan holda amalga oshirishni nazarda tutadi. 

Ma'lumotlar bazasi - EHM xotirasiga yozilgan ma' lum bir strukturaga ega, o'zaro 

bog'langan va tartiblangan ma'lumotlar majmuasi bo'lib, u biror bir ob'ektning 

xususiyatini, holatini yoki ob'ektlar o'rtasidagi munosabatni ma'lum ma'noda ifodalaydi. 

MB foydalanuvchiga strukturalashtirilgan ma'lumotlarni saqlash va ishlatishda optimal 

qulaylikni yaratib beradi. 

Ma'lumki ma'lumotlarni kiritish va ularni qayta ishlash jarayoni katta hajmdagi ish 

bo'lib ko'p mehnat va vaqt talab qiladi. MB bilan ishlashda undagi ma'lumotlarning aniq 

bir strukturagi ega bo'lishi, birinchidan foydalanuvchiga ma'lumotlarni kiritish va qayta 

ishlash jarayonida undagi ma'lumotlarni tartiblashtirish, ikkinchidan kerakli 

ma'lumotlarni izlash va tez ajratib olish kabi qulayliklarni tug'diradi. MB tushunchasi 

fanga kirib kelgunga qadar, 

ma'lumotlardan turli ko'rinishlarda foydalanish juda qiyin edi. Bugungi kunda turli 
7 

Reyting 

daftarcha 

nomeri 

Familiya Ismi 
Otasining ismi Tugilgan 

sana 

O^rtacha 

baho 

654311 Avazov Jamol Alievich 15/01/1979 4,78 

545712 Ortiqov Akram Salimovich 03/11/1978 4,61 

453225 Lazizova Saida Xo'jaevna 07/07/1980 4,52 

685564 Safarov Toshmurod Karimovich 12/04/1981 4,03 

654786 Javlonov Alisher Ozodovich 31/12/1982 3,69 

2-Rasm. Tizilmalashtirilgan ma'lumotlarga misol. 
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ko'rinishdagi ma'lumotlardan zamonaviy komp'yuterlarda birgalikda foydalanish va 

ularni qayta ishlash masalasi hal qilindi. Komp'yuterlarda saqlanadigan MB maxsus 

formatga ega bo'lgan muayyan tuzilmali fayl bo'lib, undagi ma'lumotlar o'zaro bog'langan 

va tartiblangandir. 

Demak, ma'lumotlar bazasi deganda malum bir strukturada saqlanadigan 

ma'lumotlar to'plami tushuniladi. Boshqacha qilib aytganda MB - bu malum berilgan aniq 

bir strukturaga ega bo'lgan ma'lumotlarni o'z ichiga oluvchi maxsus formatga ega bo'lgan 

fayldir. Ma'lumotlarni strukturalashtirish - bu shunchaki ma'lumotlarni tasvirlashda 

qandaydir moslikni kiritish usulidir. Odatda MB malum bir ob'ekt sohasini ifodalaydi va 

uning ma'lumotlarni o'z ichiga oladi, ularni saqlaydi va foydalanuvchiga ma'lumotlarni 

qayta ishlashda undan foydalanish imkonini yaratib beradi. 

Ma'lumotlar bazasi-bu malum bir predmet sohasiga oid tizimlashtirilgan 

(trukturalashtirilgan) ma'lumotlarning nomlangan to'plamidir. 

Ma'lumotlar bazasi tushunchasi may don, yozuv, fayl (jadval) kabi elementlar 

bilan chambarchas bog'liq (3-rasm). 

Maydon-bu ma'lumotlarni mantiqiy tashkil etishni elementar birligi bo'lib, u 

axborotni eng kichik va bo'linmas birligi bo'lgan rekvizitga mos keladi. Maydonni 

tasvirlash uchun quyidagi tavsiflardan foydalaniladi: 

Maydon nomi, masalan, familiyasi, ismi, tug'ilgan sana, lavozimi, ish staji, 

mutaxassisligi. 

 

 

Maydon uzunligi (olchami), masalan, eng k o p  simvollar sig'imi; 

1-maydon 

nomi 

2-maydon 

nomi 

3-maydon 

nomi 

   

N- 

maydon 

nomi 
       

 

l 

Maydon 

3-rasm. Ma'lumotlar bazasi tuzulmasining asosiy elementlari. Maydon turi, 

masalan, son (chislovoy), simvol (simvol'ni'y), sana/vaqt (data/vremya), 

mantiqiy (logicheskiy). 
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Maydon aniqligi, (son tipidagi ma'lumotlar uchun) masalan, sonning onlik ksr 

qismini aks ettirish uchun o'nlik raqamdan to'rtta. 

Yozuv -bu mantiqiy bog'langan maydonlar to'plami. Yozuv tuzilishi uchun uning 

tarkibiga kiruvchi maydolar tarkibi va joylashishi ketma-ketligi bilan aniqlanib, ularni har 

biri ichida elementar yozuvlarning nusxasi deb ataladi. Yozuv ob'ektning biror bir 

elementi haqida to'liq ma'lumotni ifodalaydi. 

Fayl (jadval) -bu bir xil tuzilmaga ega bo'lgan yozuvning nusxalar to'plamidir. U 

o'zicha har bir maydonda qiymatga ega. 

Misol 3. STUDENT faylidagi (jadvalidagi) yozuvlarning mantiqiy strukturasini 

tavsiflashga doir misol 4-rasmda ko'rsatilgan. Bu faylga 2-rasmda ko'rsatilga ma'lumotlar 

joylashtirilgan. STUDENT faylidagi yozuvning tuzilishi chiziqli bo'lib, u o'zgarmas 

uzunlikdagi yozuvlardan iborat. Yozuv maydonlari takrorlanuvchi qiymatlar guruhiga 

ega emas. Maydon qiymatiga murojaat uning nomeri bo'yicha amalga oshiriladi. 

 

Har bir MB jadvali o'zining birlamchi kalitiga ega bo'lishi mumkin. Birlamchi kalit 

deganda ezuvlar kaytarilmasligini ta'minlovchi maydon (polya) yoki maydonlar guruxi 

tushiniladi. Birlamchi kalit sifatida ishlatiladigan maydon eki maydonlar guruxi, bir xil 

yozuvga ega bo'lmaslik shartini bajarishi kerak. Masalan, yuqorida keltirilgan 2 rasmdagi 

jadvaldagi maydonlardan faqat reyting daftarchasi nomeri birlamchi kalit bo'laoladi. 

Boshqa maydonlarida bir xil yozuvlar takrorlanishi mumkin. Shu sabab ular birlamchi 

kalit bo'laolmaydi. Birlamchi kalit qisqa va sonli maydonlardan tashkil topishi maqsadga 

Fayl nomi STUDENT 

Maydon Kalit 

belgisi 

Maydon formati 

Nomni 

belgilash 

To4iq nomlanish 

(rekvizit) 

Tip Uzun- ligi Aniq-

ligi 

Nomer Talaba reyting 

daftarchasi nomeri 

* simvol 10  

Famil Talaba familiyasi  simvol 10  

Ismi Talaba ismi  simvol 8  

Ota.ismi Talaba otasi ismi  simvol 10  

T kun Talabaning tug'ilgan 

sanasi 

 sana 8  

O'rta_bah

o 
Talabaning o'rtacha 

bahosi 

 son 3 2 

4-rasm. STUDENT faylidagi yozuvlar mantiqiy tuzi ishini tavsifi. 
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muvofiqdir. MB jadvaliga birlamchi kalitni kiritishdan maqsad, jadvaldagi ma'lumotlarni 

izlash, tartiblashtirish va tanlab olishda qulaylikni beradi. Birlamchi kalit kiritish yoki 

kiritmaslik foydalanuvchi tamonidan MB jadvali strukturasini tashkil qilishda aniqlanadi. 

Bosh jadval yordamida qaram jadvaldagi mos ma'lumotlarni chaqirishni ta'minlash 

uchun qaram jadvalda tashqi kalit tashkil qilinadi. "Bitta-ko'pga" bog'lanish holatida 

tashqi kalit bosh jadvalda tashkil qilinadi. Birinchi va ikkinchi kalitlarni aniqlashda 

MBBT avtomatik ravishda jadvalda indekslarni quradi. 

Indekslar kiritish mexanizmi MB jadvalidagi ma'lumotlarni tez topish va ajratib olish kabi 

imkoniyatlarni beradi. 

Misol uchun, agar quyidagi jalval berilgan bo'lsa, uning mantiqiy nuqtai nazardan 

indekslari quyidagicha bo'ladi. 

 

 

 

ko'rsatgichi to'g'ridan-to'g'ri "shakar" turgan birinchi yozuvga keladi va takrorlanadi. 

Agar jadvaldagi hamma "soni">16 shartni qanoatlantiruvchi yozuvlarni chiqarish yoki 

Yozuv Tovarning tushish vaqti Tovar nomlari Soni 
№    

1 10.01.2005 Shakar 10 

2 12.01.2005 Kartoshka 50 

3 12.01.2005 Sabzi 20 

4 14.01.2005 Shakar 50 

5 14.01.2005 Sabzi 10 

6 16.01.2005 Olxo'ri 4 

Tovarning tushish vaqti Tovar nom ari Soni bo'yicha 

Sana Yozuv № Tovar Yozuv Soni Yozuv 
   №  № 

10.01.2005 1 Shakar 1 10 1 

12.01.2005 2 Kartoshka 2 50 2 

12.01.2005 3 Sabzi 3 20 3 

14.01.2005 4 Shakar 4 50 4 

14.01.2005 5 Sabzi 5 10 5 

16.01.2005 6 Olxo'ri 6 4 6 

Agar barcha yozuvlar ichidan faqat "shakar" nomli tovarni olishimiz 

kerak bo'lsa, jadvaldagi hamma ma'lumotlarni qarab ko'rish shart emas. U 

holda yozuv 
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ular ustida biror bir operatsiya bajarish kerak bo'lsa, u holda yozuv ko'rsatgichi qiymati 

"soni">16 shartni qanoatlantiruvchi birinchi turgan yozuvga teng bo'ladi. 

Bundan xulosa qilib aytganda jadvallarda "indeksatsiya" kiritish jadval 

ma'lumotlarini izlash, bir nechasini tanlab olish va ajratish kabi ishlarda qulaylikni 

tug'diradi. Bu esa o'z navbatida jadval ustida har xil operatsiyalar olib borishni 

foydalanuvchiga osonlashtiradi. Haqiqatda indekslashni tashkil etish ancha qiyin bo'lib, u 

MBni loyihalash jarayonida uning strukturasini tashkil etish vaqtida aniqlanadi. 

MBdan foydalanishda, ya'ni undagi ma'lumotlar ustida har xil ishlar bajarishda bir 

necha usullar majud. Bu usullarga baza ma'lumotlaridan foydalanishga murojaat (dostup) 

usullari deyiladi. Quyidagi baza ma'lumotlardan foydalanish usullarini ko'rib chiqamiz. 

1.Ketma-ket murojaat usuli. Ketma-ket murojaat usuli MB jadvaliga so'rovlarning 

bajarilishi uchun jadvaldagi hamma yozuvlarni qarab chiqadi. Masalan, bu usul 

yordamida birinchi yozuvdan oxirgi yozuvgacha kerakli yozuvlarni berilgan so'rov 

bo'yicha qarab, chiqib ularni ajratib chiqarish mumkin. Bu usulning uncha effektiv 

emasligi faqat uning tez izlab topishda vaqtning yoki hisoblash resurslarining ortiqcha 

ishlatilishidir. 

2.Indeksli ketma-ket murojaat usuli. Indeksli ketma-ket murojaat usuli MB 

jadvaliga berilgan so'rov bajarilishi uchun yozuv ko'rsatgichini so'rov shartini bajaruvchi 

yozuvning birinchisiga olib kelib qo'yadi. Keyin yozuv ko'rsatgichi so'rov shartini 

qanoatlantiruvchi keyingi qatorga o'tadi. Shunday qilib so'rov shartini qanoatlantiruvchi 

hamma qator o'qiladi. Demak, indeksli ketma-ket murojaat usulida jadvalda faqat so'rov 

shartini qanoatlantiruvchi yozuvlar o'qiladi.

3.To'g'ridan-to'g'ri murojaat usuli. Indeksli ketma-ket murojaat usulida jadvaldan 

bir yoki bir necha maydonlar guruhi qiymati bo'yicha to'g'ridan to'g'ri kerakli yozuvlar 

olinadi. Bu usul ikkinchi usulning xususiy holi deb qaraladi. Chunki indeksli ketma-ket 

murojaat usuli to'g'ridan-to'g'ri usulni ishlatadi. Yozuv ko'rsatgichi so'rov sharti 

qanoatlantiradigan indeksning birinchi qatoriga qo'yiladi va kerakli shartni 

qanoatlantiruvchi indeksli yozuvlarni o'qib bo'lgandan song ketma-ket murojaat usuli 

bo'yicha qator indeksi bo'yicha siljiydi. 

Paradox va Dbase MBBSda indekslar boshqa faylda saqlanadi. Oracle, SyBase, 

InterBase va SqrServer MBBSda esa indekslar birgalikda baza fayilining o'zida saqlanadi. 
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Ma'lumotlarga ishlov berish texnologiyasi bo'yicha ma'lumotlar bazasi 

markazlashtirilgan va taqsimlangan bazalarga bo'linadi. 

Markazlashtirilgan ma'lumotlar bazasi bir hisoblash tizimining xotirasida 

saqlanadi. Agar bu hisoblash tizimi komp'yuterlar tarmog'ining komponenti bo'lsa, u 

holda bunday bazaga tarmoq orqali kirish uchun ruxsat berilishi mumkin. Ma'lumotlar 

bazasi dan bunday foydalanish usuli komp'yuterlarning lokal tarmoqlarida ko'p uchiraydi. 

Taqsimlangan ma'lumotlar bazasi hisoblash tarmog'ining turli komp'yuterlarida 

saqlanuvchi bir-necha qismlardan iborat bo'lib, ular kesishuvi, xatto bir-birini takrorlashi 

mumkin. Bunday baza bilan ishlash ma'lumotlarni taqsimlangan bazasini boshqarish 

tizimining yordami bilan amalga oshiriladi. 

Ma'lumotlar bazasidagi ma'lumotlardan foydalanish huquqi bo'yicha ular lokal 

kirish huquqiga ega bo'lgan ma'lumotlar bazasi va uzoq masofadan (tarmoqdan) kirish 

huquqiga ega bo'lgan ma'lumotlar bazasiga bo'linadi. 

Tarmoqdan kirish huquqiga ega bo'lgan ma'lumotlar bazasini markazlashtirilgan 

tizimi bu kabi tizimlarning turli arxitekturasini nazarda tutadi: 

• Fayl-server; 

• Klient-server. 

Fayl-server. Ushbu kontseptsiyada tarmoqdan kirish huquqiga ega bo'lgan 

ma'lumotlar bazasi tizimining arxitekturasi markaziy EHM (fayllar serveri) sifatida 

tarmoq komp'yuterlaridan birini ajratib ko'rsatishini nazarda tutadi. Bunday komp'yuterda 

umumiy foydalanishga mo'ljallangan markaziy ma'lumotlar bazasi saqlanadi. Tarmoqdagi 

boshqa hamma komp'yuterlar ishchi stantsiyalari 
12 

funktsiyasini bajaradi. Ularning yordami bilan foydalanuvchi tizimdan markaziy 

ma'lumotlar bazasiga kirishi ta'minlanadi. Ma'lumotlar bazasi fayllari foydalanuvchi 

so'rovlariga mos ravishda ish stantsiyalariga yuboriladi. Ma'lumotlarni qayta ishlash 

asosan ish stantsiyalarida amalga oshiriladi. Ma'lumotlar bazasiga kirish intensivligi katta 

bo'lganda axborot tizimining unumdorligi pasayadi. Foydalanuvchilar ish stantsiyalarida 

lokal ma'lumotlar bazasi yaratishlari va ulardan yakka tartibda foydalanishlari ham 

mumkin. 
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Klient-server. Bu kontseptsiyada, markaziy ma'lumotlar bazasi maxsus 

komp'yuterda (Ma'lumotlar bazasi serverida) saqlanishi bilan birga, ma'lumotlarni qayta 

ishlash masalalarining asosiy qismi bajarilishini ta'minlashi zarur. 

Klient (ish stantsiyasi) tomonidan ma'lumotlarga berilgan so'rov serverdagi 

ma'lumotlarni qidirish va topishga olib keladi. Olingan ma'lumotlar (ammo fayllar emas) 

tarmoq bo'yicha serverdan klientga uzatiladi. Klient-server arxitekturasining o'ziga xos 

xususiyatlaridan biri SQL so'rovlar tilidan foydalanish hisoblanadi. 

Ma'lumotlar bazasi - axborot tmzimlarining eng asosiy tarkibiy qismi bo'lib 

hisoblanadi. Ma'lumotlar bazasidan foydalanish uchun foydalanuvchi ishini 

engillashtirish maqsadida ma'lumotlar bazasini boshqarish trizimlari yaratilgan. Bu 

tizimlar ma'lumotlar bazasini amaliy dasturlardan ajratadi. 

Ma'lumotlar bazasini boshqarish tizimi (MBBT) -bu dasturiy va apparat 

vositalarining murakkab majmuasi bo'lib, ular yordamida foydalanuvchi ma'lumotlar 

bazasini yaratish va shu bazadagi ma'lumotlar ustida ish yuritishi mumkin. 

Juda ko'p turdagi MBBT mavjud. Ular o'z maxsus dasturlash tillariga ham ega 

bo'lib, bu tillarga SUBD buyruqli dasturlash tillari deyiladi. MBBTga Oracle, Clipper, 

Paradox, FoxPro, Access va boshqalarni misol keltirish mumkin. 
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§2. Delphi vizual dasturlash vositasida ma'lumotlar bazasini yaratish 

texnologiyalari 

MBBT til vositalari va zmonaviy MBBT til vositalari tarkibiga kuyidagilar 

kiradi: 

• Malumotlarni yoritish tili, - malumotlarni mantikiy strukturasini yoritishga 

muljallangan; 

• Malumotlarni kayta ishlash tili, malumotlar ustida asosiy kiritish, uzgartirish va 

tanlash operatsiyalarini bajarilishi ta^minlash; 

• Strukturalangan surovlar tili (SQL - Structured Query Language), MB 

strukturasini boshkarish, malumotlarni boshkarish va kayta ishlashni ta’minlash; 

• Namuna buyicha surovlar tili (QBE - Query By Example), MB uchun surovlarni 

vizualyaratishni ta’minlash. 

MB bilan ishlovchi vositalar tarkibiga kuyidagilar kiradi: 

• MB bilan ishlashga muljallangan vositalarni ikki turga bulish mumkin: 

- instrumental instrumental vositalar vositalar; 

- komponentlar komponentlar. 

• Instrumental vositalarga MB xizmat kursatuvchi maxsus dasturlar va 

dasturlarpaketini kiritish mumkin. 

• Komponentlar MB bilan operatsiyalar bajaruvchi dasturlarni ratishga 

muljallangan elementlardir. 

Instrumental vositalar tarkibiga kuyidagilar kiradi: 

• Borland Database Engine (BDE) - dasturlardan turib MB murojatni 

amalga oshirib beruvchi drayverlar va bibliotekalar tuplamidan 

iborat protsessordir. 

• BDE Administrator -BDE xar xil parametrlarini sozlovchi dastur. 

• Database Desktop - jadvallar, QBE va SQL surovlarni yaratuvchi va 

uzgartiruvchi dastur. 

• SQL Explorer - MB ni kursatuvchi va uzgartiruvchi dastur. 

• SQL Builder -SQL surovlarni vizual yaratishga kumaklashuvchi dastur; 
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• SQL Monitor - MB da SQL surovlarni bajarilish tartibini kuzatuvchi dastur. 

• Data Pump -MBlari urtasida malumotlarni kuchiruvchi dastur. 

• InterBase Server Manager - InterBase serverini ishga tushuruvchi dastur 

• SQL Links - korporativ MBBT murojat drayverlari. 

• InterBase Server - InterBase serverini klient va server kismi. MB uchun 

komponentlar tarkibiga kuyidagilar kiradi: 

• MB MB komponentlari komponentlari ikkiga ikkiga bulinadi bulinadi: 

- Vizual 

- Novizual 

• Novizual komponentlar jadval ichida joylashgan malumotlarga murojatni amalga 

oshirishga muljallangan. Ular MB jadvallari va vizual komponentlar orasida ishtirok 

etadi. 

• Vizual komponentlar dasturlarni interfeys kismini yaratishda ishlatiladi. Ular 

yordamida foydalanuvchi jadvallardagi ma'lumotlarni kurishi va uzgartirishi mumkin. 

MB uchun komponentlar tarkibiga kuyidagilar kiradi: 

• MB bilan ishlovchi komponentlar kuyidagi panellarda joylashgan: 

- Data Access 

- Data Controls 

- dbExpress 

- BDE 

- ADO 

- Decision Cube 

- QReport 

- InterBase 
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Data Controls paneli 

•DBGrid- tablitsa; 

• DBNavigator - navigatsion interfeys; •DBText- izox; 

• DBEdit - bir katorli matn redaktori; •DBMemo- kup 

katorli matn redaktori; •DBImage- grafik komponent; 

•DBListBox- ruyxat yaratish komponenti; 

• DBComboBox - ochiladigan ruyxat; 

• DBCheckBox - individual' tanlash komponenti; 

• DBRadioGroup - bir biriga boglik tanlash komponentlari guruxi; 

• DBLookupListBox - boshka ma'lumotlar tuplamidan yaratiladigan 

ruyxat komponenti; 
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• DBLookupcomboBox - boshka ma'lumotlar tuplamidan 

yaratiladigan ochiladigan ruyxat; 

•DBRichEdit- tulik funktsiyali redaktor; •DBCtrlGrid- yaxshilangan 

tablitsa; •DBChart- diagramma. 

 

BDE paneli 

Table - MB jadvali asosidagi ma'lumotlar tuplami; Query 

-SQL-surovlarga asoslangan ma'lumotlar tuplami; StoredProc - 

serverda saklanadigan chakiruv protsedurasi; 

DataBase - MB bilan ulanish; 

Session - MB bilan joriy ish seansi; 

BatchMove - ma'lumotlar guruxi usti amallar bajarish; 

UpdateSQL -SQL-surovga asoslangan, ma'lumotlar tuplamini uzgartirish; 

 

ADO paneli 

• ADO panelida ADO (Active Data Objects) texnologiyasi bilan ma'lumotlarni 

boshkarishga muljallangan komponentlar joylashgan: 

- ADOConnection - ulanish; 

- ADOCommand - komanda; -ADODataSet - ma'lumotlar tuplami; -ADOTable -Table 

ma'lumotlar tuplami; 

- ADOQuery -Query ma'lumotlar tuplami; 

- ADOStoredProc - server chakiruv protsedurasi; 

 

InterBase paneli 

• InterBase panelida InterBase serveri bilan ishlovchi komponentlar joylashgan: 
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- IBTable - Table ma'lumotlar tuplami; 

- IBQuery - Query ma'lumotlar tuplami; 

- IBStoredProc - serverdagi chakiruv protseduralari; 

- IBDatabase - MB bilan ulanish 

- IBTransaction - tranzaktsiya; 

- IBUpdateSQL - SQL-surov asosida ma'lumotlarni uzgartirish; 

- IBDataSet - ma'lumotlar manbai; 

- IBSQL - SQL-surovni bajarish; 

- IBDataBaseInfo - MB xakida ma'lumot;
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QReport paneli 

• QReport panelida xisobotlar tayyorlashga muljallangan komponentlar joylashgan: 

• QuickRep - xisobot shabloni; 

•QRSubDetail-«asosiy-buysinuvchi» boglangan jadvallar uchun xisobot satri; 

• QRStringsBand - xisobotni belgili satri; 

• QRBand - xisobot satrlari; 

• QRChildBand - xisobotni boshka satr koshidagi satri; 

• QRLabel - metka; 

• QRDBText - matnli kator; •QRExpr- matematik ketma-ketliklar; •QRSysData- tizim 

malumotlari; •QRMemo- kup katorli matn; 

• QRExprMemo - kup katorli matematik ketma-ketliklar; 

• QRRichText - formatlangan matnlar; 

• QRDBRichText - jadval uchunformatlangan matnlar komponenti; •QRImage- grafik 

komponent; 

• QRDBimage - jadval uchun grafik komponent; •QRPreview- xisobotni kurish 

oynasi; 

• QRChart - diagramma. 

- IBSQLMonitor - SQL-surovlarni bajarilish monitori; 

- IBEvents - serveragi xodisalar; 
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§3. MBBTda ishlatiladigan ilovalarni tuzish va ishlatish vositalari 

Delphi tarkibiga kiruvchi MBni boshqarishda ishlatiladigan ilovalarni tuzish va 

ishlatish vositalariga quyidagilar kiradi: 

-BDE (Borland Datebase Engine). Borland ma'lumotlar ba zasi mashinasi. Uning 

tarkibiga dasturlar to'plami kiritilgan bo'lib, ular lokal va klient server toifasining MBga 

murojaat qilishni va undan foydalanishni tashkil qilib beradi. 

-SQL LINKS. Boshqa MBBT bilan (Masalan, SysBase, Oracl, MsSQL Server) ishlash 

uchun drayverlar. Delphi tizimi Paradox va Dbase MBBT lari uchun SQLni ishlatmaydi, 

BDE yordamda bajaradi. 

-DBE administrator - bu utilita bo'lib MBga psevdonimlar, parametrlar va MB 

o'rnatish uchun ishlatiladi. Delphida tuzilgan ilova yordamida MB bilan ishlash vaqtida 

Mbdan foydalanish uning psevdonimi bo'yicha amalga oshiriladi. 

-DataBase Destop (DBD). Mbni ko'rish, taxrirlash va tashkil qilish uchun maxsus 

vosita (utilita). Bu utilita asosan Paradox va Dbase MBBT uchun uning jadvallari bilan 

ishlashga yo'naltirilgan bo'lib, ayrim hollarda boshqa tashqi MBBT jadvallari bilan 

ishlashda ham foydalaniladi. Ilovalarning o'zaro bog'lanishining umumiy modeli 

quyidagi sxemada berilgan. 

 

-DataBase Explorer (SQL Explorer). MB psevdonimi, konfiguratsiyasi va 

strukturasini ko'rish, hamda MB jadvaliga so'rov berish utilitalarini o'z ichiga oladi. 

-SQL manitor. SQL so'rovlarini bajarish vositasi. 

 



26 

-Visual Query Builder. Delphi tarkibiga kiruvchi vosita bo'lib, SQL -so'rovlarini 

avtomatlashtirishni tashkil etadi. 

-Data Dictionary -ma'lumotlar lug'ati. MB jadvali maydonlari atributini saqlaydigan 

vosita. 

-MB bilan ishlash uchun vizual bo'lmagan komponentalar. Vizual bo'lmagan 

komponentalar ilovalar bilan MB jadvalini bog'lashga xizmat qiladi. Bu komponentalar 

Data Access kompanentalar palitrasida joylashgan. 

-MB bilan ishlash uchun vizual komponentalar. Delphi vizual komponentalari 

ma'lumotlar to'plami yozuvlarini (masalan, komponenta TDBGrid) akslantirish uchun va 

foydalanuvchiga qulay interfeys yaratish uchun ishlatiladi. Bu komponentalir Data 

Controls komponentalar palitrasida joylashgan. 

-Hisobotlar tuzish uchun komponentalar. Bu komponentalar 20 dan ortiq bo'lib ular 

Qreport komponentalar politrasida joylashgan bo'lib, hisobotlarni tuzish uchun 

ishlatiladi. 

MB tayyor ilovasi bilan ishlash uchun vositalarning umumiy tarkibi quyidagi 

sxemada keltirilgan. 

Bu sxemaga asosan, biz quyidagi ketma-ketlik zanjiriga ega bo'lamiz. 

Ilova => BDE => MB Vizual bo'lmagan komponentalardan BDE ga 

to'g'ridan to'g'ri chiqiladi, u foydalanuvchi interfeysini ta'minlaydi. Delphi yordamida 

MB bilan ishlash uchun yaratilgan dasturlarning asosiy xususiyati ularda BDE 

ishlatilishidir. BDE ning asosiy vazifasi dasturlar bilan MB o'rtasida bog'lovchi ko'prik 

vazifasini bajaradi. 
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МБ 

 

DTYC 

 

MB bilan ishlash uchun Delphi komponentlari. 

Delphi MB bilan ishlashda etarlicha katta guruh komponentalariga ega. 

Data Access (ma'lumotlarga ruxsat yoki ma'lumotlardan foydalanishga ruxsat) 

sahifasida MBni boshqa ma'lumotlar bilan o'zaro ta'sirida ishlatiladigan komponentalar 

mavjud. Ularning ko'pi vizual bo'lmagan (ko'rinmaydigan) bo'lib o'z ichiga jadval, so'rov, 

ko'rish, o'zgartirish va boshqalar tavsifini oladi. 

Data Controls (ma'lumotlar bilan bog'liq elementlarni boshqarish) sahifasida 

asosan vizual komponentalar bo'lib ularga ma'lumotlar bilan bog'liq komponentalar 

deyiladi. 

Delphi ma'lumotlar bazasi bilan muloqot (unga murojaat) qilish uchun Data Source 

komponentini ishlatadi. Bu komponent to'g'ridan to'g'ri ma'lumotlarni belgilamaydi, u 

Data Set komponentasiga murojaat qiladi. Quyidagi jadvallarda vizual va vizual 

bo'lmagan komponentalar tavsifi berilgan. 

MB bilan ishlash uchun vizual bo'lmagan asaosiy komponentlar haqida 

ma'lumotlar 
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Komponent Vazifasi 

Tsession MB bilan aloqa o'rnatish seansi bo'lib, MB ochishda, yopishda va uni 

parametrli boshqarishda ishlatiladi. 

Tdatabase MB. Bu komponent himoyalashgan MB bilan birlashtirish jarayonini 

boshqarish uchun xizmat qiladi. 

TDatasource Ma'lumotlar manbai. Ma'lumotlarga murojaat qilish komponentlari 

bilan ma'lumotlarni aks ettirish komponentalar o'rtasida bog'lovchi 

element vazifasini bajaradi 

TDataSet Klientlar ma'lumotlari to'plamiga, ma'lumotlarga MBni mashinasidan 

foydalanmasdan murojaat qilish vositasi sifatida ishlatiladi. MB bilan 

ishlashda xossa va metodlarni aniqlaydi. 

TTable MBning jadvaliga (fayliga) kirish vosita sifatida xizmat qiladi 

Tquery So'rov. Ma'lumotlar jadvalini SQL tili yordamida tanlab olish 

imkonini beradi 

TIndex Dets MB jadvali indekslari haqida ma'lumotni beradi 

TField Dets MB jadvali maydonlari haqida ma'lumotni beradi 

TBatch Move Bir MB to'plamini boshqasiga ko'chirishda ishlatiladi 

MB 

bil 

an ishlash uchun vizual komponentlar haqida ma'lumotlar 

Komponent Vazifasi 

TDBtext Ma'lumotlar to'plami maydonini joriy yozuvini ko'rsatadi 

TDBEDIT Joriy yozuvni ko'rish va maydon qiymatlarini o'zgartirishni 

ta'minlaydi. (tahrirlash) 

TDBCheckBox Mantiqiy turga (Boolean) ega bo'lgan maydonlarning joriy 

yozuvini ko'rish va uning qiymatlarini tahrirlashni ta'minlaydi. 

TDBMenu Menyu-maydon(posl komentariya) qiymatlarini matn muharriri 

rejimida ko'rish va o'zgartirishni ta'minlaydi 

TDBGrid MB jadvali. Ma'lumotlar to'plamini jadval ko'rinishida 

chiqarishni ta'minlaydi. 

TDBNavigator MB navigatori. MB yozuvlarini engillashtirishni ta'minlaydi. 

Shuningek yozuvlarni qo'yish, olib tanlash va tahrirlash imkonini 

beradi. 

TDBChart Ma'lumotlarni grafik ko'rinishida tasvirlashda ishlatiladi. 



Vizual va vizual bo'lmagan komponentlar bir-birlari bilan xossalar yordamida 

bog'lanadi. Xossalar asosan ilovalarni ishlab chiqishda aniqlanadi. 

BDE administrator utilitasi bilan ishlash 

Delphida ilova yordamida MBdan foydalanish uchun Ilova=> BDE=> MB 

ketma-ketligi bajariladi. Bu shuni bildiradiki har qanday MBga ilovadan murojaat 

qilinganda uning aniq adresi BDEga uzatiladi. BDE o'zining maxsus funktsiyalarini MB 

bilan bog'lanishda ishlatadi. BDE aniq bir MB bilan ishlaganda quyidagilarni bilishi 

kerak. 

-MB qaysi joyda joylashganligini; 

-MB parametrlari haqidagi ma'lumotni. 

MB parametrlari va uning joylashishi MB psevdonimida aniqlanadi. Psevdonim - 

MB ga berilgan biror nom bo'lib MBga mantiqiy murojaat qilinganda ishlatiladi. 

MB psevdonimi BDE adminisrator utilitasi yordamida aniqlanadi. 

MBning har bir jadvali uchun fayl tuziladi. Xuddi shunday jadval indekslari va 

memo maydonlari uchun maxsus fayllar tuziladi. MBga dastur va utilitalardan murojaat 

qilinish MBning psevdonimidan amalga oshiriladi. Psevdonim BDE administrator 

utilitasi yordamida aniqlanadi. Psevdonim - biror bir nom bo'lib MBga Delphi 

komponenti ilovalari (masalan Ttable va Tquery) tamonidan mantiqiy murojaat qilishda 

ishlatiladi. 

Aytaylik biz tashkil qilishimiz kerak bo'lgan MB "C:\PROBA\" katologida 

joylashsin. Biz tashkil qiladigan psevdonim nomi aytaylik "Proba" bo'lsin. BDE 

administrator utilitasini ishga tushiramiz. Asosiy menyudan Object/New buruqlarini 

tanlaymiz. Hosil bo'lgan darchadan tuziladigan MB turini aniqlash uchun "Standart" 

parametrini o'zgartirmasdan Ok tugmasini bosamiz. Chap oynada (MB administratori 

oynasida) biz "Standartl" nomini ko'ramiz va uni "Proba"ga o'zgartiramiz. Qng oynada 

MB parametrlari berilgan, u erda faqat Path (yo'l) o'zgartiriliadi. Bu parametr MB 

katalogiga yo'lni ko'rsatadi. Path nomini ko'rsatib, o'ng darchadan uch nuqtali tugmani va 

keyin chap oynadan "Proba"ni 

tanlab Ok tugmasini bosamiz. MB uchun aniqlangan psevdonimni saqlash uchun 
26 
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chap oynaga kelib, sichqoncha o'ng tugmasini chiqillatib dialog oynasidan "Apply" 

elementini tanlaymiz va Ok tugmasini bosamiz. Keyin esa BDE administratoridan 

chiqamiz. 

MBni psevdonimini tuzishni yanada chiquriroq ko'rib chiqaylik. Uning 

algoritmi quyidacha: 

1. BDE administrator utilitasi ishga tushiriladi. 

2. Menyudan Object=>New buyrugi beriladi. 

 

4.Chap oynadan Standartl nomi yangi psevdonim nomiga ozgartiriladi. 

5.Ong oynada Path qatoriga otilib, uch nuqtali tugmacha va keyin Ok bosiladi. 

6.Menyudan Object=>Apply=>Ok buyrugi beriladi. 

 

MB jadvalini tuzish uchun DataBase Desktop (DBD) utilitasini ishga tushirish 

zarur. Utilitani ishga tushirgandan keyin ishchi psevdonimi o'rnatiladi. Ishchi 

psevdonimni o'rnatish uchun bosh menyudan File=>Working Directory buyrug'ini berib, 

keyin ro'yxatga kiruvchi "Aliases" tanlanib psevdonim nomi "Proba" ko'rsatiladi va Ok 

tugmasi bosiladi. 

3.Darchadan Standart turi ozgartirilmasdan Ok tugmasi bosiladi. 
^ BDE Administrator C:U>rogram FilesVCommon Fi les\Bo r land Share d\BDE... _ ||П||Х| 

f Object Edit View Options Help 

 

All Database Aliases 

Databases Configuration (  

- tg Databases 

1 S База данных MS A ■■ fg 

Abdu_pi 1 "g abdu__prcib 3 

DBDEMOS 

DefaultDD 

< > 

л 

m 

New Database Alias  

 Database Drivei Nanne | 

B[STANDARD С 

1 

I 

S items in Databases.  OK | Cancel Help   

9.BDE administratordan chiqiladi. 
 ^ BDE Administrator C:\Program Files\Common Files\Borland Shared\BDE.. 

■ 

Object Edit View Options Help 

& X 

 All Database Aliases   Definition of STANDARD1   

 Databases Configuration  Definition 

 н DBDEMOS   Type STANDARD 1 
 h Sg DefaultDD  DEFAULT DRIVER PARADOX  

 h Sg IB Local   ENABLE BCD FALSE  

 н ~ Файлы dBASE IJI  PATH -41 1 

 - ™ Файлы Excel t STANDARD1 V     

 < JIL 1 A"     

| Database Location.      

MB jadvalini tuzish 
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MB jadvalini tuzish uchun asosiy menyudan File=>New=>Table buyrug'i 

bajariladi. Paydo bo'lgan Create Table oynada MB turini aniqlab, (masalan Paradox 7 

yoki DBase Windows) Ok tugmasi bosiladi. Yangi paydo bo'lgan oynada MB jadvali 

strukturasi aniqlanadi. 

Ma'lumotlar bazasini yaratish uchun avvalambor uning modelini, ya'ni uning 

strukturasini ishlab chiqarish zarur. Buning uchun MBda maydon tushunchasi 

kiritilgan bo'lib uning strukturasini aniqlaydi. Maydonni aniqlash quyidagi 

elementlardan tashkil topadi. 

■ maydon nomi (Fields Name). 

■ maydon turi (Type). 

■ maydon o'lchami (Size). 

■ maydon kaliti (Key). 

Maydon nomi - 10 tagacha lotin xarfi va sonlardan tashkil topgan bulishi mumkin. 

Maydon turlari matnli, sana, mantikiy, izohli (primechanie) va sonli bo'lishi 

mumkin. 

Maydon o'lchami - simvol yoki sonlarning maksimal soni. 

Masalan, DBase MBBT uchun maydon turlari quyidagilar bilan aniqlanadi. 

-"C" simvolli (matnli) qiymatlarni bildirib uning uzunligi 255 tagacha bo'lishi 

mumkin; 
307 308 

-"N" sonli qiymatlarni bildirib, uning diapazoni -10 ^+10 ; 

-"D" sana (data) qiymatini bildirib, uning o'zgarish diapazoni 01.01.9999 dan 

31.12.9999 gacha; 

-"L" mantiqiy qiymatni bildirib, "True" va "False" qiymatlarni qabul qiladi; 

-"M" memo (izohli) bo'lib qatorli qiymatlarni qabul qiladi, har bir qator 255 

tagacha simvol olishi mumkin. Memo ma'lumotlari maxsus Dbt kengaytmali faylda 

saqlanadi. 

MB ning turli fayllari orasidagi munosabat bir xil nomli maydonlar orqali 

o'rnatiladi. Har bir MB DBF kengaytirilgan nom bilan komp'yuter xotirasida saqlanadi. 

Misol 4. Misol tariqasida xodimlarni hisobga olishni avtomatlashtirish masalasini 

qaraylik. MBni tashkil qilish uchun oldin uning kartatekasini ishlab chiqarish lozim: 
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hisobga olish tartib raqami; ismi va familiyasi; tug'ilgan yili; maoshi va hakazo. Bularni 

hisobga olgan holda MBning strukturasini ishlab chiqamiz. 

 

MBning jadvalini yaratish algortmi quyidagi ketma-ketlikda bajariladi: 

1. DataBase DeskTop utilitasi ishga tushiriladi. Buning uchun quyidagi 

buyruqlar ketma-ket bajariladi. 

Pusk=>Programmi'=>Borland Delphi=>DataBase DeskTop 

2. DataBase DeskTop oynasining bosh menyusidan quyidagi buyruq bajariladi. 

File=>Working Directory 

3. Hosil bo'lgan Set Working Directory muloqot darchaining Aliases idan 

MB psevdonimi aniqlanadi.

 Turi Uzu

n ligi 

Kasr 

kismi 

Izoh 

Maydon nomi     

Kodx N 3 - O'isobga olish tartib raqami 

Famx C 20 - Xodim ismi va familiyasi. 

Tyx D 8 - Tug'ilgan yili 

Omx N 10 2 Oylik maoshi 

MUT C 15 - Mutaxassisligi 

Lavjzim C 15 - Lavozimi 

BULIM C 15 - Bo'lim nomi 

Ich1 D 8 - Ishga qabul qilgan kun 



 

4. Menyudan File=>New=>Table buyrug'i bajariladi. 

5. Hosil bo'lgan Create Table muloqot darchasitdan MB turi aniqlanadi 

(masalan, Paradox yoki Dbase Windows). Bu darchada MBning bir qancha turlari 

mavjud. 

6. MB strukturasi tashkil qilinadi. 

7.Save As buyrug'i berili, jadval nomi kiritiladi va Ok tugmasi bosilib saqlanadi. 

9.Agar MBga ma'lumotlar kiritish kerak bo'lsa menyudan File=>Open buyrug'i berilib, 

keyin fayl tanlanadi va ma'lumotlar kiritiladi. 

MB jadvali uchun oddiy dastur ilovalarini tuzish 

Delphi dasturlash vositasida tuzilgan ilovalarni saqlash uchun yuqoridagi tuzilgan 

"Proba" katologida "App" nomli podkatolog tashkil qilamiz. Delphi tizimini ishga 

tushirib, uning komponentalar palitrasi qatoridan Data Accessni ishga tushirib, undan 

vizual bo'lmagan komponentasi Ttable olinadi (bu komponentani darchaga olish uchun u 

ko'rsatilib sichqoncha chap tugmasini ikki marta tez-tez chiqillatmoq kerak bo'ladi). 

Ttable komponenti ma'lumotlarni saqlash va undan foydalanishda ishlatilib, u 

ma'lumotlarni akslantirishda vizual komponentalar DTBGrid, Tedit va boshqalar bilan 

birgalikda ishlatiladi. 

Ttable komponentasini formaga (darchaga) joylashtirgandan keyin, Object 

Inspectorida uning xossalari quyidagi ketma-ketlikda o'rnatiladi: 

-Ttable komponentasi ajratiladi (belgalanadi); 

-DataBase Name MB psevdonimi xossasi o'rnatiladi, Proba psevdonimi ro'yxatdan 

olinadi yoki kiritiladi; 

-Table Name (MB jadvali nomi) xossasi o'rnatiladi (bu erda MB jadvali nomi 

ro'yxatdan olinadi yoki kiritiladi; 

-Active xossasi o'rnatiladi ("True" qiymati tanlanadi). 

jgMalabase Desklop |_ || ГП |[ X | 

File Edit: Tools Window" Help 

П il I-;-: 1   

 Set Working Directory ["X 1 

1 
 Working Directory: 

Browse... Aliases: 

1 ^J 

i QK | Cancel Help 
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Bu bajarilgan buyruqlardan keyin Ttable komponentasi bilan MB jadvali 

orasida aloqa to'liq o'rnatiladi. Ttable komponentasi kabi endi formaga 
30 

TDataSource komponentasini joylashtiramiz. Bu komponenta vizual va vizual bo'lmagan 

komponentalar o'rtasida aloqa o'rnatish uchun xizmat qiladi. Shu tufayli TdataSource 

komponentasiga ma'lumotlar manbai deyiladi. TdataSource komponentasi uchun DataSet 

(ma'lumotlar to'plami nomi) xossalari o'rnatiladi (Table1 nomi olinadi). 

Data Controls menyu qatoridan foydalanib formaga TdbGrid komponentasini 

joylashtiramiz va uning DataSuurce xossasini o'rnatamiz (DataSource1 qiymat bilan). Bu 

TdbGrid komponentasi ma'lumotlar to'plami yozuvlarini jadval ko'rinishda akslantirishda 

xizmat qiladi. 

Ishlab chiqilgan loyixa (loyiha)ni saqlash uchun menyudan quyidagi buyruqlar 

ketma-ket bajariladi. File=>Save Project As. Oldin loyixa formasi (masalan Appl1.pas 

nom bilan), keyin loyixaning o'zi (masalan Appl.dpr nom bilan) saqlanadi. 

Delphi tizimidan chiqmasdan turib tuzilgan ilovani ishga tushirish uchun F9 

tugmasini bosish kifoya. Ilovani tizimdan tashqarida ishlatish uchun esa oldin tizim 

ichida Ctrl+F9 tugmasini bosish kerak bo'ladi. Bu holda ilovani tizimdan tashqarida 

ishlatish uchun maxsus .EXE kengaytmali fayl avtomatik ravishda tashkil etiladi 

(masalan, Appl.exe). Bu faylni tizimdan tashqarida ishlatganda tuzilgan ilova ishga 

tushadi. Mbga qo'shimcha yozuv kiritish uchun oxirgi yozuvga kelib Insert tugmasini 

bosish, kiritilayotgan yozuvdan vos kechish uchun ESC tugmasini bosish, yozuvni to'liq 

o'chirish uchun esa Ctrl+Del tugmasini bosish kerak bo'ladi. 

MB jadvali bilan ishlash uchun oddiy ilova yaratish algortmlari bilan tanishib 

utamiz va ular quyidagi ketma-ketlikda bajariladi: 

1 .Delphi tizimi ishga tushirilib BDE komponentalar palitrasidan Ttable komponentasi 

formaga qo'yiladi. 

2. Formadagi Ttable komponentasi belgilanib, DataBase Name 

xossasida Mbning psevdonimi aniqlanadi. 

3. TableName xossasidan MB jadvali nomi aniqlanadi. 

4. Active xossasi True qiymat bilan o'rnatiladi. 

5. Data Acciss komponentalar palitrasidan TdataSource komponentasi 

formaga qo'yiladi. 
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6. TdataSet xosasi Table1 nom bilan o'rnatiladi. 

7. Data Controls komponentalar palitrasidan TDbGrid komponentasi 

formaga qo'yiladi. 

9.DataSourse xossasi DataSoursel nom bilan o'rnatiladi. 

9. Menyudan File=>Save Project As buyrug'i berilib, oldin forma 

keyin loyiha saqlanadi. 

10. Loyihani ishga tushirish uchun F9 tugmasi bosiladi. Natijada quyidagi 

formaga ega bo'lamiz. 

TDBNavigator komponenti. MB jadvalida ma'lumotlarni surish, o'chirish, 

yozuvni siljitish va taxrirlash uchun Data Controls komponentalar palitrasida maxsus 

TDBNavigator komponentasi mavjud. 

Bu komponentani formadagi MB jadvaliga quyidagi tartibda o'rnatish mumkin. 

1. MB jadvali formasi ekranga chaqiriladi. 

2. Data Controls komponentalar palitrasidadan TDBNavigator komponentasi 

formaga joylashtiriladi. 

3. TDBNavigator komponentalar xossasidan DataSourse xossasi 

DataSoursel nom bilan o'rnatiladi. 

4. Menyudan File=>Save Project As buyrug'i berilib, oldin forma 

keyin loyiha saqlanadi. 

5. Loyihani ishga tushirish uchun F9 tugmasi bosiladi. 

Natijada jadvali ma'lumotlarni surish, o'chirish, yozuvni siljitish va taxrirlash kabi 

tugmachalarga ega bo'lgan quyidagi formaga ega bo'lasiz. 

 

Komp'yuter quyidagi dastur kodlarini avtomatik ravishda tuzadi 

unit xodim; 

interface 

uses 

O'qituvshiilar haqida ma'luimotnoma 

 IKODX FAMX TVX О MX  

► 1 36 Karinriov Mu^affr 02/08/1981 1ooo

oo 

■ 1 

 1 37 S obirov N^imjon  800Q0  

 1 38 Zufarov I^afarjon  120000  

 1 33 Usmonov Sobir  800Q0  

 1 40 Aumedov SaKob  1OO

OOO 

 

 1 41 N aimov Akbarjon  1 1 

OOCIO 

 

 1 42 MaHmudov Tohirjon  11oo

oo 

- 
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Windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, 

Forms, 

Dialogs, StdCtrls, Grids, DBGrids, DB, DBTables, ExtCtrls, DBCtrls; type 

TForm1 = class(TForm) Label1: TLabel; Table1: TTable; DataSource1: 

TDataSource; DBGrid1: TDBGrid; DBNavigator1: TDBNavigator; private 

{ Private declarations } public 

{ Public declarations } end; var 

Form1: TForm1; implementation {$R *.dfm} end. 

Ikkita jadvalda ishlash uchun ilova tuzish 

Bitta formada ikkita bog'liq ma'lumotlar to'plami uchun ilova tuzishni ko'rib 

chiqaylik. Forma ilovasini "App21.pas" fayliga loyixa ilovasini "App2.drp" fayliga yozib 

qo'yaylik. 

Ilovaga Ttable komponentasini qo'shamiz (Table2 nom bilan). Proba Mbning 

Prihod jadvali bilan ishlash uchun uchun uning xossalarini qo'yamiz (xossalari qiymati 

Table1 komponentasi kabi bo'lib, Table Name ga jadval nomi Prihod.dbf beriladi). 

Table2 Avtive xosasini "True" qiymatda o'rnatamiz. Formaga TdataSurce 

komponentasini joylashtiramiz (DataSource2 nom bilan). Bu komponenta uchun DataSet 

xosasini Table2 qiymat bilan o'rnatamiz. TDBGrid komponentasini formaga 

joylashtiramiz (DBGrid2 nom bilan) va DataSource xossasini o'rnatamiz (DataSource1 

qiymat bilan). Ilovani ishga tushiramiz. Ma'lumotlarni izlash va fil'trlash 

Kompornent TDataset va uning davomchilari ma'lumotlar bilan ish yuritishda 

maxsus usullarga ega: 

• maydon qiymati bo'yicha ma'lumotni izlash; 

• ma'lumotlarni fil'trlash; 

• zakladka qo'yish va unga o'tish. 

Ma'lumotni izlash. Malum belgilangan yozuvlarni ma'lumotlar to'plamdan izlab 

topish uchun ikkita usul mavjud: Locate va Lookup. 

Locate - usuli biror maydonning berilgan yozuvi bo'yicha kerakli yozuvni topish 

imkonini beradi. Uning umumiy ko'rinishi quyidagicha: 

Function Locate(Const KeyFields: String; Const KeyValues: 

Variant; Options: TLocateOptions): Boolean; 

Bu erda KeyFields -ma'lumotlarni izlashda qatnashadigan maydonlar nomlari. Ular bir 

biridan nuqta vergul bilan ajratiladi. 

KeyValues -bir yoki bir necha izlanadigan maydon qiymatlari. Agar izlanadigan 

qiymatlar bir necha bo'lsa massiv varianti funktsiyasi qilib berish zarur. 
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Options -izlanadigan parametrlar to'plami. U quyidagi qiymatlarni saqlash 

mumkin: 

loCaseInsensitive. Registrni hisobga olmasdan izlash. 

loPartialKey. Maydon qiymati to'liq berilmagan holda izlash. Masalan, 'So' 

boshlanadigan familiyalar izlanadigan bo'lsa. U holda ma'lumotlar to'plamidan So bilan 

boshlanadigan familiyalar 'Sobirov' va 'Soatov' lar topiladi. 

Agar izlanayotgan yozuv topilsa funktsiya Locate -true qiymat qaytaradi. 

Fermer xo'jaliklarida ma'lumotlar bazasini oddiy ilovalar yaratish algortmlari 

asosida ishlab chiqish chiqamiz va u quyidagi ketma-ketlikda bajariladi: 

Ilovani yaratish algoritmi: 

1. Delphini ishga tushuramiz. 

2. Formaga Label 1 komponentasini o'rnatamiz va uning Caption 

xossasini "Malumotlar bazasidan izlsh" so'ziga almashtiramiz. 

3. Formaga DataSource (Ma'lumotlar manbai), Query (So'rov) va 

DBGrid komponentalarini joylashtiramiz. Ularning qayidagi xossalarini o'rnatamiz. 

DataSource1 komponenti. 

  

  

 

4. Yuqoridagilarni to'g'riligini tekshirish uchun Query1 

komponentasining Active xossasini True qilib o'rnatamiz. 

5. Data Controls komponentalar palitrasidadan TDBNavigator 

komponentasini formaga joylashtiramiz. 

6. TDBNavigator komponentalar xossasidan DataSourse 

xossasini DataSourse1 nom bilan o'rnatamiz. 

Xossa Qiymati 

DataSet Query 1 

Query1 komponenti. 

Xossa Qiymati 

DataBaseName RequestLive 

SQL 

ABDU_PR True 

Select * From Xodims 

DataSource1 komponenti. 

Xossa Qiymati 

DataSourse DataSourse 1 
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7. Button1 komponentasini formaga joylashtiramiz va uning 

Caption xossasini "Chiqish" so'ziga almashtiramiz. 

9.Edit1 komponentasini formaga joylashtiramiz. 

9.Button2 komponentasini formaga joylashtiramiz va uning Caption xossasini 

kerakli so'ziga almashtiramiz. 
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§4. Fermer xo'jaliklari ma'lumotlar bazasini mul'timediyali tahlilining 

dasturiy vositasini ishlab chiqish 

Fermer xo'jaliklarida ma'lumotlar bazasini oddiy ilovalar yaratish algortmlari 

asosida ishlab chiqish uchun daslab MB jadvali bilan ishlash uchun oddiy ilova yaratish 

algortmlari bilan tanishib o'tamiz va ular quyidagi ketma- ketlikda bajariladi: 

MB jaadvali tashqil qilinganinda har bitta nomlanish uchun alohida qator kiritiladi 

va ular quyidagicha kursatiladi: 

-katalog buyicha mahsulotlar guruxlari; 

- mahsulot nomlanishi; 

- buyurtma berilgan sanasi; 

- mahsulot bahosi; 

- mahsulot miqdori; 

- buyurtmani o'rinlash muddati. 

Fermer xo'jaliklari buyicha ma'lumotlar kuyidagicha guruhlanadi. 

1- Nur; 

2- Gani; 

3- Trud; 

4- Izzat; 

5- eshimbetov Ibraim; 

6- erimbetov Nurimbat; 

7- Abdullo; 

8- Dilshod Muxayyo; 

 Vapaev Jangaboy; 

 Davlatboev Sobir; 

 Siytmomut; 

 Zamir; 

 Mangit ovul; 

 Kadirbek Azizbek; 

 Nurimbetov Ibragim; 

 Tuliboy Iskandarov; 
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 Yangi fermer; 

 Xolbaeva Darmon. 

Yangi ma'lumotlar kiritishda «Kiritish» formasin bir nechta maydonlar buyicha 

to'ltirish kerak. 

Agarda jadvalda ma'lumotlar o'zgartirish kerak bo'lsa, uni amalga oshirishga 

bo'ladi. Ular kod, sana, gruxlar buyicha soralanadi. Bul «Fermer» MTP dasturi 

ma'lumotlar oqimi xisobini engillatish uchun xizmat qiladi. Quyidagilar xolatlar buyicha 

ma'lumotlar kiritilishi mumkin: -kelib tushgan buyurtmalarni kiritish; -buyurtmaning 

o'rinlanishini kiritish; -dastur holatini tekshirib turish. Dastur kuyidagi holatlarni 

o'rinlaydi: -ma'lumotlarni hisoga olish; -mezonlar buyicha tanlash imkoniyatlari; 

-buyurtmaning o'rinlanmagan qismi haqida axborot; 

Proektni amalga oshirish uchun MB da barcha axborotlar guruhlar belgilari 

buyicha qiymat atributlarga bo'lingan, har bitta qiymat o'zidan MB jadvalin ko'rsatadi. 

Qo'yilgan masalaning har bitta maydonining ko'rsatilishi quyidagi jadvalda keltirilgan. 

 

4.1-jadval. 
№ Fermerlar Atributlar 

1 01-Nur Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani o'rinlash vaqti. 

2 02-Gani Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani o'rinlash vaqti. 

3 03-Trud Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani o'rinlash vaqti. 

4 04-Izzat Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani o'rinlash vaqti. 

5 05-eshimbetov Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 
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Natijada quyidagi formaga ega bolamiz. 

 

Ibraim miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani orinlash vaqti. 

6 06-erimbetov 

Nurimbat 

Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani orinlash vaqti. 
 

07-Abdullo Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani orinlash vaqti. 
 

08-Dilshod 

Muxayyo 

Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani orinlash vaqti. 
 

09-Vapaev 

Jangaboy 

Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani orinlash vaqti. 
 

10-Davlatboev 

Sobir 

Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani orinlash vaqti. 
 

11-Siytmomut Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani orinlash vaqti. 
 

12-Zamir Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani orinlash vaqti. 
 

13-Mangit ovul Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani orinlash vaqti. 
 

14-Kadirbek 

Azizbek 

Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani orinlash vaqti. 
 

15-Nurimbetov 

Ibragim 

Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani orinlash vaqti. 
 

16-Tuliboy 

Iskandarov 

Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani orinlash vaqti. 
 

17-Yangi fermer Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani orinlash vaqti. 
 

18-Xolbaeva 

Darmon 

Kodi'; Nomi; Buyurtma berilgan sanasi; Mahsulot 

miqdori; Mahsulot tannarxi; Shartnoma bahosi; Guruhi; 

Buyurtmani orinlash vaqti. 
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4.1-rasm. Ma'lumotlar bazasini formasini yaratish loyihasi.  

Ma'lumotlar bazasini formasini yaratish loyihasi ishlab chiqilgandan so'ng 

uni ishga qo'shishda qo'yidagi forma ilovasiga ega bo'lamiz. 

 

4.2-rasm. Ma'lumotlar bazasi loyihasining ishga tushirilishi. 

Bu formani ishga tushirgandan so ng Editl tahrirlash qatoridan kerakli o'qtituvchi 

kodi kiritiliadi. Bu erda izlash 'Redaktorlash' maydoni bo'yicha amalga oshirilayapdi. 

Natijada shu kodli maxsulot kiritilib, kursor shu kod to'g'risida turadi. Buni ketma-ket 

amalga oshirish ham mumkin. Uning uchun 'Redaktorlash' maydoni o'rniga 'Qo'shish' 

maydonini buyicha yozish kifoya. 

MBdan izlashni ikkita maydon bo'yicha ham tashkil qilish mumkin uning uchun 

ikkinchi taxrirlash maydonini kiritish kerak bo'ladi. 

Filter xossasi MB yozuvini qanoatlantiruvchi shartni o'z ichiga oladi. Shart 

solishtirish va mantiqiy operatorlarni o'z ichiga olishi mumkin. Masalan, Prise_sell>100. 

Bu shart bizning yuqorida yaratgan MB uchun kodi 100dan katta maxsulot shartnoma 

narxlarini ekranga chiqaradi. Kuyidagi oynada kodi 100 dan katta ma'lumotlarni ekranga 

chiqarish tasvirlangan. 

 

 



43 

 

4.3-rasm. Tugmachalarga ega bo'lgan malumotlar bazasi loyixasi. Ma'lumotlar 

bazasini tuzish uchun «MTP Fermerlar» ning daslapki malumotlarini kuyidagicha 

keltiramiz. «MTP Fermerlar»da bir nechta tYrli ekin mahsulotlari undiriladi. Ulardan 

Texnik ekinlar, Kartoshka, sabzavot, poliz va boshka Ozuka ekinlari, Boshka ekinlar, 

Sholi, Makka don uchun, Boshka turdagi don ekinlari, Paxta, Moyli ekinlar va boshqalar. 

Bu mahsulotlar hisob-sanoq ishlarini olib borilib, buyurtma orinlangan mahsulotlar 

kompyuter xotirasiga kiritilib boriladi. Kompyuterda «Access» tizimida ushbu 

malumotlar bazasi saqlaniladi. Bundagi kamchiliklardan biri ish kuni tugagandan so ng 

bazaga kiritilib bunga qandayda bir vaqt talab etiladi. Shuning bilan birga kiritilgan 

vaqtinda xato kamchiliklarga yul quyilishlari mumkYn. Shuning uchun keltirilib o'tilgan 

kamchiliklarni yo'qotish maqsatida Delfi dasturlash tilida «MTP Fermerlar»ga tegishli 

bo lgan ma' lumatlarni saqlash va avtomat turda mahsulotlar haqidagi buyurtma 

orinlangan, va yangi mahsulotlarga berilayotgan buyurtmalarni bazaga kiritish qulay 

amalga oshiriladi. 

Delfi dasturlash tilida «MTP Fermerlar»da ma lumotlar bazasi uchun dasturiy 

vosita ishlab chiqishni korib otamiz. 

Loyiha dasturining modul umumiy holda namunaviy korinishda qo llaniladi. 

Modullar buyicha dastur qismlarin biriktirish va ishlatish uchun mo ljallangan dastur 

loyihasi Projectl asosida boshqarilib barcha modullar kuyidagi tuzilishga ega bolgan 

namunaviy korinishda qollaniladi. unit Unitl; interface 

// interfeysli tarif sektsiyalori 

implementation 

// Realizatsiya sektsiyalari 

end. 
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Interfeysli tariflash sektsiyasida boshqa dasturiy modullarga kiradigan dasturiy 

elementlar tariflanib (tiplar, sinflar, protsedura va funktsiyalar), realizatsiya sektsiyasinda 

Ushbu elementlarning ishlash mexanizmi yaratiladi. Modulni bunday ko'rinishda ikkiga 

ajratish dastur algoritmlarining bir-biri bilan almashishning qulay mexanizmin beradi. 

Realizatsiya sektsiyasinda yozilganlar faqat ushbu modul ishida ko'rinadi va tashqaridan 

ularni ko'rish imkoniyati yo'q. 

Bizning xolatda fermer xo'jaliklarida ma'lumotlar bazasi loyixasi Object Pascal 

tilida ezilgan dasturlardan iborat. Bu dastur Delphi tomonidan avtomat yoratiladi va faqat 

bir nechta qatordan iborat. Ularni kurish uchun Delphi da bosh menyudan Project/ View 

Source bo'limi tanlanadi. Delphi quyidagi ko'rinishga ega bo'lgan Fermer yasamasiga ega 

bo'lgan dastur kodi oynasini ko'rsatadi. program Fermer; uses Forms, 

MainForm in 'MainForm.pas' {frmMain}, AddProduct in 

'AddProduct.pas' {frmAddProduct}, ProductsList in 

'ProductsList.pas' {frmProductsList}, Unit1 in 'Unit1.pas' 

{Form1}, Unit2 in 'Unit2.pas' {Form2}; {$R *.res} begin 

Application.Initialize; 

Application.CreateForm(TfrmMain, frmMain); 

Application.CreateForm(TfrmAddProduct, frmAddProduct); 

Application.CreateForm(TfrmProductsList, frmProductsList); 

Application.CreateForm(TForm1, Form1); 

Application.CreateForm(TForm2, Form2); Application.Run; end. 

Loyiha Fermer dasturi kompilyator tomonidan Object Pascal tilida yozilgan ikkita 

dasturlar ustida ishlashdan iborat va dastur tuzilishi besh o'rinlovchi operatordan iborat. 

Kod bo'yicha kiritishni mahsulotlar buyicha «Redaktorlash» orqali quyidagi dastur 

kodi buyicha kiritamiz. var 

frmProductsList: TfrmProductsList; implementation uses 

MainForm; {$R *.dfm} 

procedure TfrmProductsList.FormClose(Sender: TObject; 

var Action: TCloseAction); begin 

frmMain.tblProducts.Refresh; end; 
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procedure TfrmProductsList.Button1Click(Sender: TObject); 

begin 

frmMain.tblProductsAll.Post; 

Close; 

end; 

«MTP Fermerlar»ning ma'lumotlar bazasining Del'fi tilida yaratilgan asosiy oynasi 

ko'rinishi sifatida dasturning bosh aynasi keltirilgan. 

 

Ushbu oynada mahsulotlarning biri bilan ish boshlash uchun instrumentlar paneli 

ro'yhatidan mos jadval nomin tanglash kerak. Oynaning yuqorgi qismi jadval holatini va 

uning maydonda yozilgan ma'lumotlarni ko'rsatadi. Quyidagi maydon-bu tekstli maydon, 

bunda jadval ustida ishlangan operatsiyalar olib boriladi. Bu jadvaldagi axborotlarni keng 

ma'noda ko'radigan bo'lsak, bular ketma-ketlik asosida kiritilgan: Kodi; atamasi; 

buyurtma berilgan vaqti; buyurtma o'rinlanish vaqti; guruhi. Bu funktsiyalar ma'lumotlar 

asosida o'rinlanadi. 

Instrumentler panelida menyuda «Mahsulotlar» bo'limida «Ko'shish», 

«Redaktorlash» va «O'chirish» tugmachalari bor. «Redaktorlash» va «Kiritish» 

tugmachalarining bosilishi asosida redaktorlash rejimi ishga qo'shiladi. Quyida 

4.5-rasmda keltirilgan. 

 

4.4-rasm. Buyurtmani urinlashning bosh oynasi. 
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4.5-rasm. Buyurtmani olish va shartnoma asosida ma'lumotlarni qo'shish. Agarda 

ekrandagi ma'lumotlarni foydalanuvchi o'chirish istagi bulsa unda «Mahsulotlar» 

bo'limidagi «O'chirish» tugmasini tanlash kerak. Bu tanglangan tugmadan «O'chirish» 

oynasi oshiladi va undagi «OK» tugmasini bosish orqali ma'lumot o'chiriladi. 4.6-rasm. 

ЪЩШВВВВЯЙШШШШШШШВШЩ 
I M агьлумсттларни учириш I 

4.6-rasm. Jadvaldan ma'lumotlarni o'chirish. 

Fermer xo'jaliklari buyicha barcha ma'lumotlarning tahlilini utkazishda faqatgina 

bitta jadval ko'rinishidagi ma'lumotlar kamlik qiladi. Asosan fermer xo'jaliklari 

ma'lumotlar bazasini tahlilini mul'timediyali tasvirda paralel ko'rib borish yaxshi 

ahamiyat kasb etadi. Shuning uchun fermer xo'jaliklarida ma'lumotlar bazasini 

mul'timediyali tahlilining dasturiy vositasini amalda qo'llanishning quyidagi bosh oynada 

ko'rib o'tsa bo'ladi. 
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4.7-rasm. Fermer xo'jaliklarida ma'lumotlar bazasini mul'timediyali 

tahlilining dasturiy vositasining asosiy oynasi. 
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XULOSA 

Mazkur bitiruv malakaviy ishida fermer xo'jaliklari ma'lumotlar bazasini 

mul'timediyali tahlilining dasturiy ta'minotini yaratishga bag'ishlangan bo'lib, dastlab u 

jaryon o'rganilib chiqib, asosiy jadvallar va ular orasidagi bog'liqliklar o'rnatildi. Natijada 

Borland Delphi 7.0. qo'shimchasini ishlab chiqishda qulayli usullarni qullanish bilan 

ma'lumotlar bazasi yaratildi. 

Malakaviy bitiruv ishning maksadi fermer xo'jaliklari ma'lumotlar bazasini 

mul'timediyali tahlilining dasturiy ta'minotini yaratishdan iborat bulib, maqsadga erishish 

uchun quyidagi vazifalar bajarildi: 

• Ma'lumotlar omborida ishlashni mukammal o'rganildi; 

• Fermer xo'jaliklari ma'lumotlar bazasini strukturasi bilan tanishish va shu 

asosida ma'lumotlar strukturasini yaratildi; 

 Ma'lumotlar bazasiga qo'yilgan asosiy talablar bilan tanishib olish, buning 

asosida kerakli so'rovnoma va hisobotlarni ajratildi; 

• Ma'lumotlar ombori uchun "Microsoft Office Access"dan foydalangan holda 

dasturiy ta'minot yaratildi, shu bilan birga qulay va engil interfeys ishlab 

chiqildi; 

 Borland Delphi 7.0. qo'shimchasini ishlab chiqishda qulayli usullarni urganish 

bilan ma'lumotlar bazasi yaratildi. 

Malakaviy bitiruv ishining xulosalari «Fermer» xo'jaliklari komp'yuter tarmog'i 

adminstratorlari, operatorlari va boshqa karxonalar uchun uslubiy qo'llanma sanaladi. 
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Ilova
program MyEdit; 

uses Forms, 

MainUnit in 'MainUnit.pas' {MainForm}, 

ChildUnit in 'ChildUnit.pas' {ChildForm}, 

Unitl in 'Unitl.pas' {Forml}, 

Unit2 in 'Unit2.pas' {Form2}, 

Unit3 in 'Unit3.pas' {Form3}, 

Unit4 in 'Unit4.pas' {Form4}, 

Unit5 in 'Unit5.pas' {Form5}; 

{$R *.RES} 

begin 

Application.Initialize; 

Application.CreateForm(TMainForm, MainForm); 

Application.Run; 

end. 

unit MainUnit; 

interface 

uses 

Windows, Messages, SysUtils, Classes, Graphics, Controls, Forms, Dialogs, 

Menus, StdActns, ActnList, DB, Grids, DBGrids, ExtCtrls, DBCtrls, DBTables, 

ComCtrls, ToolWin, StdCtrls, Buttons, Mask; type 

TMainForm = class(TForm) 

MainMenul: TMainMenu; 

Nl: TMenuItem; 

N3: TMenultem; 

N6: TMenultem; 

N7: TMenuItem; 

N8: TMenuItem; 

Nl4: TMenuItem; 

Nl5: TMenuItem; 

WindowMenu: TMenuItem; 

http://www.ziyonet.uz/
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OpenDialogl: TOpenDialog; 

ActionListl: TActionList; 

Arrangel: TWindowArrange; 

Cascadel: TWindowCascade; 

Closel: TWindowClose; 

MinimizeAlll: TWindowMinimizeAll; 

TileHorizontallyl: TWindowTileHorizontal; 

TileVerticallyl: TWindowTileVertical;

N13: TMenuItem; 

N16: TMenuItem; 

Copy1: TEditCopy; 

Cut1: TEditCut; 

Paste1: TEditPaste; 

StatusBar1: TStatusBar; 

DataSource1: TDataSource; 

ToolBar1: TToolBar; 

ComboBox1: TComboBox; 

Timer1: TTimer; 

warehouse: TTable; 

DBGrid1: TDBGrid; 

N2: TMenuItem; 

N4: TMenuItem; 

N5: TMenuItem; 

N9: TMenuItem; 

N11: TMenuItem; 

SpeedButton1: TSpeedButton; 

SpeedButton2: TSpeedButton; 

SpeedButton3: TSpeedButton; 

SpeedButton4: TSpeedButton; 

SpeedButton5: TSpeedButton; 

SpeedButton6: TSpeedButton; 

SpeedButton7: TSpeedButton; 

SpeedButton8: TSpeedButton; 

Panel1: TPanel; 

Panel2: TPanel; 

Panel3: TPanel; 

Panel4: TPanel; 

Memo1: TMemo; 

N10: TMenuItem; 

N12: TMenuItem; 
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N17: TMenuItem; 

N18: TMenuItem; 

N19: TMenuItem; 

N20: TMenuItem; 

N21: TMenuItem; 

N22: TMenuItem; 

Label1: TLabel; 

Splitter1: TSplitter; 

N23: TMenuItem; 

N24: TMenuItem; 

Query1: TQuery;

N25: TMenultem; 

procedure ComboBox1Change(Sender: TObject); 

procedure SpeedButton1MouseMove(Sender: TObject; Shift: TShiftState; X, Y: 

Integer); 

procedure SpeedButton2MouseMove(Sender: TObject; Shift: TShiftState; X, Y: 

Integer); 

procedure SpeedButton4MouseMove(Sender: TObject; Shift: TShiftState; X, Y: 

Integer); 

procedure SpeedButton5MouseMove(Sender: TObject; Shift: TShiftState; X, Y: 

Integer); 

procedure SpeedButton7MouseMove(Sender: TObject; Shift: TShiftState; X, Y: 

Integer); 

procedure SpeedButton8MouseMove(Sender: TObject; Shift: TShiftState; X, Y: 

Integer); 

procedure SpeedButton1Click(Sender: TObject); procedure 

SpeedButton3Click(Sender: TObject); procedure N19Click(Sender: TObject); 

procedure N20Click(Sender: TObject); procedure N21Click(Sender: TObject); 

procedure N22Click(Sender: TObject); procedure SpeedButton6Click(Sender: 

TObject); procedure N24Click(Sender: TObject); procedure 

SpeedButton7Click(Sender: TObject); procedure N25Click(Sender: TObject); 

private 

{ Private declarations } public 

{ Public declarations } 

end; 

var 

MainForm: TMainForm; editmark: boolean; 

stDay : array[1..7] of string[11] = ('voskresen'e','ponedel'nik','vtornik', 

'sreda','chetverg','pyatnitsa','subbota'); 

implementation 

uses Unit1, Unit2, Unit3, Unit4, Unit5; {$R *.DFM} 

procedure TMainForm.ComboBox1Change(Sender: TObject); begin 
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warehouse.Active := false; if combobox1.ItemIndex = 0 then begin 

warehouse.TableName:='Audi.db'; end;

if combobox1.ItemIndex = 1 then begin 

warehouse.TableName:= 'Volkswagen.db'; 

end; 

if combobox1.ItemIndex = 2 then begin 

warehouse.TableName := 'Skoda.db'; end; 

warehouse.ReadOnly:=false; 

dbgrid1.ReadOnly:=true; 

warehouse.Active := true; 

end; 

procedure TMainForm.N8Click(Sender: TObject); 

begin 

application.Terminate; end; 

procedure TForm1.BitBtn1Click(Sender: TObject); 

begin 

mainform.warehouse.InsertRecord([edit2.text,edit1.text,maskedit1.text,spinedit2.text,spinedit1.text,'',combob 

ox1.text,datetimepicker1.date]); 

mainform.Memo1.Lines. Add(timetostr(time)+' Proizvedena pokupka '+edit1.Text+' [ '+spinedit2.Text+' po tsene 

'+spinedit1.text+'r. ]'); 

edit1.Clear; 

edit2.Clear; 

combobox1.Clear; 

maskedit1.Clear; 

spinedit1.Clear; 

spinedit2.Clear; 

form1.Close; 

end; 

procedure TForm1.BitBtn2Click(Sender: TObject); 

begin 

edit1.Clear; 

edit2.Clear; 

combobox1.Clear; 

maskedit1.Clear; 

spinedit1.Clear; 

spinedit2.Clear; 

Form1.Close; 

end; 

end.
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Toshkent axborot texnologiyalari universiteti Nukus filiali «Komp'yuter 

injeneringi» fakul'teti « Axborot texnologiyalari» kafedrasining 4-kurs 

talabasi Qannazarov Shariarning «Fermer xo'jaliklari ma'lumotlar bazasi 

tahlilining mul'timediyali tasviri» 

bitiruv malakaviy ishiga berilgan 

F I K R 

Ushbu Qannazarov Shariarning bitiruv malakaviy ishi bugungi kunning dalzarb 

masalalaridan biri sanalgan qishlox xo'jaligida fermer xo'jaliklari uchun ma'lumotlar 

bazasining mul'timediali tasvirini ob'ektga yunaltirilgan dasturlash tilida dasturiy 

vositasini yaratishga qaratilgan. 

Ishning turtinchi paragrafida, asosiy masala fermer xo'jaliklari ma'lumotlar bazasin 

"Microsoft Office Access"da ishlab chiqilib va uning mul'timediyali tasviri Del fi 

ob'ektga yunaltirilgan dasturlash tilida dasturiy vositasi ishlab chiqilgan. Uning 

natijasida ushbu ishlab chiqilgan dasturiy vosita yordamida foydalanuvchilar uchun 

qulay imkoniyat yaratalgan. 

Ishning asosiy natijalarini quyidagicha ko'rsatibo'tsak bo'ladi: 

•S Ma'lumotlar omborida ishlashni mukammal o'rganilgan; 

•S Fermer xo'jaliklari ma'lumotlar strukturasi bilan tanishish va shu asosida 

ma'lumotlar strukturasini yaratildi; 

S Ma'lumotlar bazasiga qo'yilgan asosiy talablar bilan tanishib olish, buning 

asosida kerakli so'rovnoma va hisobotlarni ajratildi; 

•S Ma'lumotlar ombori uchun "Microsoft Office Access"dan foydalangan 

holda dasturiy ta'minot yaratildi, shu bilan birga qulay va engil interfeys 

ishlab chiqildi; 

S Borland Delphi 7.0. qo'shimchasini ishlab chiqishda qulayli usullarni 

urganish bilan ma'lumotlar bazasi yaratildi. 

Bitiruv malakaviy ishining tadqiqot natijalarini amaliyotda Fermer xujaliklarida, 

ayniqsa Respublika tumanlari statistika bo'limlarida uslubiy qullanma sifatida 

foydalansa bo'ladi. 

Xulosa qilib aytganda, Qannazarov Shariarning bitiruv malakaviy ishi yaxshi 

bajarilgan, qo'yilgan talablarga to'la jabov beradi va «yaxshi» baholashga loyiq deb 

xisoblayman.

B. Salimova 

Katta o'qituvchi Yu.Qutli'muratov 

Fikr bildiruvchi, ilmiy 

rahbar: 

Ilmiy maslaxatchi: 
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Toshkent axborot texnologiyalari universiteti Nukus filiali «Komp'yuter 

injeneringi» fakul'teti « Axborot texnologiyalari» kafedrasining 4-kurs 

talabasi Qannazarov Shariarning «Fermer xo'jaliklari 

ma'lumotlar bazasi tahlilining mul'timediyali tasviri» 

bitiruv malakaviy ishiga berilgan 

TAQRIZ 

Taqriz qilinayotgan ushbu Qannazarov Shariarning bitiruv malakaviy ishida 

«Fermer» xo'jaliklari ishlab chiqarishi ma'lumotlar bazasini avtomatlashtirish va 

ma'lumotlarni xar qil tahlil qilishga yo'naltirilgan bo'lib, mazkur ish «Fermer» 

xo'jaliklariga berilgan shartnomalar va ularning o'rinlanishini parallel turda jadvalli va 

mul'timediali tahlil o'tkaz uchun dasturiy vosita yaratishga qaratilgan 

Bitiruv malakaviy ishi kirish, to'rtta paragraf, xulosa va foydalanilgan adabiyotlar 

ruyhatidan iborat. 

Kirishda tanlangan mavzu dolzarbligi isbotlangan hamda bitiruv malakaviy 

ishining maqsadi va qo'yilgan maqsadga erishish uchun asosiy masalalar berilgan, 

ishning tarkibi yoritilgan. 

Birinchi paragrafta ma'lumotlar bazasi haqida asosiy tushunchalar keltirilib o'tilib, 

har qanday axborot tizimining maqsadi real muhit ob'ektlari haqidagi ma'lumotlarga 

ishlov berishdan iborat ekanliklari keltirilib o'tiladi. 

Ikkinchi paragrafta Delphi vizual dasturlash vositasida ma'lumotlar bazasini 

yaratish texnologiyalari va undagi MB bilan ishlovchi vositalar tarkibi haqida keltirilib 

o'tilgan. 

Uchinchi paragrafta MBBTda ishlatiladigan ilovalarni tuzish va ishlatish 

vositalari yoki Delphi tarkibiga kiruvchi MBni boshqarishda ishlatiladigan ilovalarni 

tuzish va ishlatish vositalari haqida keltirilib o'tilgan. 

To'rtinchi paragrafta Fermer xo'jaliklarida ma'lumotlar bazasini mul'timediyali 

tahlilining dasturiy vositasini ishlab chiqishning algoritmi haqida va ularning bajarilish 

ketma-ketligi keltirilib o'tilgan. 

Xulosada asosiy qilingan ishning natijalari yoritilgan. 

Qannazarov Shariarning bitiruv malakaviy ishi mavzusi to'g'ri tanlangan va 

ishning ayrim texnik turdagi kamchiliklarni xisobga olmaganda bitiruv malakaviy ishiga 

qo'yilgan talablarga to'la jabov beradi va uni «yaxshi» baholashga loyiq deb 

xisoblayman. 

Taqrizchi: fiz.-mat.f.n. dots. Saparov Z. 


